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Introduction

The purpose of this manual is to provide additional support to students in EE/EE 497/597,
Digital Systems Rapid Prototyping, who will be using the Xilinx ISE software to rapidly proto-
type digital design on the Xilinx Spartan-3 Starter Kit (S3Kit). This manual supplements the
existing documentation on the S3Kit [1] and the material on the Xilinx ISE 6.3i [2] computer
aided design tool by introducing a coordinated set of examples which will take the user through
the most common steps necessary for design entry, functional simulation, logic synthesis, and the
actual configuration of the Xilinx Spartan-series FPGA on the S3Kit.

The guide is organized into five chapters which cover the following topics:

Chapter 1: General information is presented about the S3Kit and the Xilinx ISE 6.3i
Design tools.

Chapter 2: A simple four bit binary counter design example is introduced and used to
show the common steps associated with schematic capture design entry,
functional simulation, design implementation, and the Spartan 3 XC3S200
FPGA configuration.

Chapter 3: A four bit binary to seven segment LED design example is introduced to
illustrate the common steps associated with hardware description language
design entry in VHDL, logic synthesis, functional simulation, and XC3S200
implementation.

Chapter 4: The four bit binary counter and the binary to seven segment LED examples
presented in Chapters 2 and 3 are combined to illustrate how designs can be
created using hybrid schematic capture techniques and hardware description
languages.

Chapter 5: References.
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Chapter 1: The S3Kit and Xilinx 6.31i Computer Aided Design Tool

The S3kit Board
The S3Kit has many features that facilitate experimentation in reconfigurable logic design

as well as the general rapid prototyping of digital logic. The S3K:it is shown below in Figure 1.1.
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Figure 1.1: The Xilinx Spartan-3 Starter Kit.

The S3Kit is a stand-alone board for experimenting and developing prototypes with
FPGASs using Xilinx FPGA architecture. The S3Kit has one Xilinx Spartan XC3S200 FPGA. An
on-board 50 MHz oscillator drives the FPGA. More information about this S3Kit board can be
found in [1].

The Xilinx ISE Foundation Series Software
Designs that are entered on the S3Kit require the use of special Computer Aided Design,
CAD, software to configure the Xilinx Spartan-series FPGA. The software used by students is the

Xilinx ISE Foundation Series tool suite. This software runs on a PC under Windows/Unix and it
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supports design entry (via schematic capture, state diagram entry, and hardware description lan-

guage), logic synthesis, logic simulation, timing analysis, and device configuration.
S

Processes for Source: "t

g
-8  Create New Source
E-@f  Design Entry Utiities
E-@F  UserConstraints

B G Synthesize-XST
B3 Implement Design

#-&3}  Generate Programming File

Figure 1.2: The Design Cycle Supported by Xilinx ISE Foundations Series Software.

The general engineering design cycle which is supported by the Xilinx Foundation Series
CAD software is highlighted in Figure 1.2. It includes the design entry, synthesis, simulation,
implementation, verification, and programming phases, the function of which, will now be briefly
described.

Design Entry: In this stage of the design cycle the design is specified in a form that is

recognizable by the Xilinx design automation tools. Xilinx tools support design entry

using schematic capture, hardware description languages (Verilog/VVHDL, state dia-

gram specification or a combination of these techniques.

Synthesis: Whenever a design is entered using a high-level language or state diagram

specification the design automation tool must synthesize the relatively abstract repre-

sentation into its low-level logical representation. This step is not necessary for com-

ponents of the design that have been entered through schematic capture. The Xilinx

tools support this option for several HDL’s (e.g. ABEL, VHDL, and Verilog).

Simulation: This phase of the design process allows for the logical correctness of the

design to be validated before it is implemented. As design errors are exposed correc-

tions will often be made by repeating the design entry portion of the design cycle.

Implementation: This phase is concerned with converting the design information into

a form that can be used to configure the targeted FPGA/CPLD device so that it will
behave in the manner that is intended.

Verification: This phase of the design is used to verify that the resulting implementa-
tion meets timing and other constrains. This is very important for high speed designs.

The examples in this document do not utilize this phase of the design cycle.
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Programming (Device Configuring): The resulting bit stream that was produced

during the implementation phase to represent the design is downloaded directly (or
indirectly through flash memory, etc.) to the targeted device. There are several pro-
gramming standards supported by the X3K:it (such as JTAG, Xchecker and MultiL-
INX). The design examples discussed in this manual will utilize the standard
parallel port which utilizes a parallel cable supplied by S3Kit which connects to the

parallel port of a typical PC or unix workstation.

Note: In the following Chapters, the XC3S200FT256 is selected for logic/design implementation.
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Chapter 2: Schematic Capture Design Example

Example

In this chapter, a simple four-bit binary counter will be used to illustrate the common steps
needed to enter a digital design using schematic capture techniques, perform functional simula-
tions, implement the design on the S3Kit (locking the Xilinx XC3S200 1/O pins to specific signals
specified in the design), and configure (program) the XC3S200. The binary counter design which
will serve as a simple example is shown in Figure 2.1. In this design, the four outputs from the
binary counter will each be connected to a built-in LED on the S3Kit. The counter will be clocked
by a relatively slow clock (~1HZ) to allow the operation to be viewed on the S3Kit by the user. The
clocking signal will originate from an internal 50 MHZ oscillator which will be directed through a
24 bit prescaler network. Both the 4-bit counter and the 24 bit prescaler circuit will be implemented

using Xilinx’s counter macros.

4 Built in LEDs
~1HZ [T 11

Divider Logic Clock o
(32 bit prescg|er) ———® 4-bit Binary Counter

50 MHZ

System —p
Clock

Figure 2.1: Binary Counter Example

Setting up a Project
To enter this design, first start the Project Navigator of Xilinx ISE 6.3i by double clicking

on the Project Navigator Icon, of ISE 6.3i from the Window’s Desktop.
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The Project Navigator will then display the last project the tool worked on. If the previous
project is accessible, it displays the project’s flow. Otherwise, the tool will show a warning (This
warning can be ignored!). For a new project, select the File menu and select New Project as
shown in Figure 2.2. This window allows the user create a New Project. For the binary counter

design example, we would like to create a New Project.

E

_ [ Console { Fnd

Figure 2.2: Xilinx ISE Series Software New Project Menu.



Version 1.01  1/5/2004

A New Project window will then appear. It will have the following fields: Project Name
(Name of project), Project Location (location to store files), and Project Device Options. Name
the project and place it as your desire. Since we are demonstrating schematic capture design cap-
ture techniques in this chapter, the input source is schematic diagram and the Design Flow for this
design can be set to XST VHDL or XST Verilog as shown in Figure 2.3. The targeted FPGA
device is a Xilinx Spartan 3 XC3S200 family device, specifically a XC3S200FT256 FPGA (it is

written directly on the device).

New Project m
—Enter a Name and Location for the Project
Project Name: Project Location:
tutarial-ch2 cxiling\tutorial-ch2

— Selectthe type of Top-Level module for the Project

Top-Level Module Type:

Schematic >

< Eeind | MNext > Cancel Help
MNew Project m
—Selectthe Device and Design Flow for the Project
Property Name Value
Device Family Spartan3
Device xc3s200
Package 266
Speed Grade -4 Z|
Top-Level Module Type Schematic
Synthesis Tool XST (VHDLVerilog)
Simulatar Other
Generated Simulation Language VHDL

<Back I Next» I Cancel | Help

Figure 2.3: New Project Window

When all the fields are completed as shown in Figure 2.3 then single click on the Next but-

ton THREE times (incluiding the add source windows, we will add new source next) and Finish



Version 1.01  1/5/2004

Button at the third window. The Xilinx Foundation Series Project Navigator window will now
appear as shown in Figure 2.4.

On the left side of the Project Manager window under the Files tab, the project source
files are displayed in a hierarchical (tree structured) manner. To add files to the project (you will
be shown how to add a schematic file as source), point the cursor to the top level (xc3s200-ft256)
of the source tree, then press and hold the right mouse button and select the New Source option
(or you can add new source from Project pull-up menu). This will cause the file that was added to
be included as part of the design and be utilized by the Xilinx CAD software during the project
compilation process. To delete a file from the project, used the same method but this time select
the Remove option. (One should be aware that when a file is removed from the project, it is not
actually deleted from the hard disk. It is just not included in this project)

Project source files Source Viewing Area

nxiiinx - Project Navigator - c:\xi!inx\tutrial—chZ\tuturi!—diZ.npl
peeazraazfe epee||: ez = @] Fllsssn|e]

e 1
E tutorial-ch2

7 2 i v [ 3 SV Y oy i ]
' =

Processes for Source. "xc3s200 41256

E Create New Source
=@ Design Entry Utilities

A Emply Log) =]

||[MITFT¥ ]\ Console A FndinFies  §_ Wamings } Brgs [
Hierarchy is up to date. [ ] B

Messages console window

Figure 2.4: Xilinx ISE Project Manager Window
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Design Entry

Design entry using schematic capture techniques involves employing a CAD tool (such as
the Xilinx ISE software) to enter a complete logic level schematic. This requires that the user use
the CAD tool to graphically enter the symbols that represent each of the components that make up
the design and then use the tool to ‘wire’ the components to one another to form the complete
schematic diagram. To enter this mode in the Xilinx Foundation software select the Project menu
on Xilinx Project Navigator (Figure 2.5a). At the New window, select Schematic and enter a
File Name. This is shown in Figure 2.5b. An informational window will appear with the sche-
matic setup once you once you click Next. To enter the schematic workspace, click Finish at the
informational window. You should be at what is shown in Figure 2.6.
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Figure 2.5: Create Schematic Source

10
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Figure 2.6: Schematic Editor Window

In the case of the four-bit binary counter example, components are needed for the internal
logic for the prescaler and counter, and components for the 1/0 pads and buffers. We will use the
high level macros which are provided by Xilinx (these macros are themselves created in a hierar-
chical manner using low level gate and flip-flop primitives). To implement the design we have
chosen to use two type of binary counter macros from Counter Category, the CB4CE to form the
basic four bit counter, and two instances of the CB16CE macro to form the prescaler logic. (Note:
When you have completed placing a symbol, press once on the Escape key is a quick way to exit
the selection before you move on to the next selection!) This design requires one input, a clock
signal, and four outputs, the outputs of the 4 bit binary counter. Interfacing with the outside world
like this requires that appropriate 1/0 pads and 1/0 buffering components be used. In this case will

need one instance of the components, 1/0 Maker or 1/O Pad(To add a pad to the input buffer or

11



Version 1.01  1/5/2004

output buffer, add a small segment of wire to the buffer and click on the pad selection button as
shown in Figure 2.6, select input or output pad. Then, click at the location of where the pad is to
be added.), and IBUFG, and four instances of the components I/O (direction on adding output
maker coming up!), and OBUF. The IBUFG and OBUF symbols are from 1/O Category. From
General Category, you can find symbols for Vcc and Gnd. It is assumed that the output of this
design will drive four of the external discrete LEDs. These LEDs are wired up in a manner where

a logic high will light them up and a logic low will deactivate them (common cathode configura-

tion).
. ' ' ' ' Output Buffer
i CB4CE /
B N Output Pad
e J—_ =
CB16CE CB16CE
Input Pad
/ g L mien —— ' " 15—
Pa — 1
Input Bufferl : ; ; : ;
(Global) —= =

Figure 2.7: 4-bit Binary Counter Example

Figure 2.7 shows the completed four-bit binary counter schematic. In this design, the com-
ponents are all wired together using a combination of nets (wires) and simple busses (collection of
nets). This was accomplished in the case of individual nets by first invoking the net/bus drawing

tool by pressing Ctrl-W or the second button on quick-access toolbar (as shown in Figure 2.7).

12
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Then the cursor was placed at the point where each net begins (such as a pin on a component)

after which the left mouse button was pressed once (single clicked). The cursor was then moved

to the desired termination point (such as another component pin in the design) and the left mouse

button was then pressed (single clicked). Busses were created in a similar manner. Now, place a

short segment of bus as shown in Figure 2.7 to both of the CB16CE symbols. Select the bus

added to the left CB16CE by a left mouse click and click the right mouse button for a working

menu. You need to select Object Properties (Figure 2.8a). Once Object Properties has been

selected, edit the value field as shown in Figure 2.8b. The value field has been re-named to

Q(15:0).

CB16CE

_ . : . i ; s i ;i : :
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3 : Zoam L4
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(@)
x
Cateqgary
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- QR ‘View and edit the attibutes of the selected nets
Hame Yalue Visible New |
MNarme arso) Add
FortPolarity | Mot a port Add ﬂl
[elete |
QK I Cancel | Apply | Help

(b)
Figure 2.8: Object Properties

13
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You should continue the similar process for the right CB16CE symbol and named that bus
QQ(15:0). The on-board clock (50 MHz) is connected to the left CB16CE. The most significant
bit (Q15) of the output of the left CB16CE is used as clock for the right CB16CE. A connection
between output signal Q(15) and clock input at the right CB16CE can be accomplished with
name association. In order to do this, place a short segment of wire at the right CB16CE clock
input, with steps shown in Figure 2.8, change the value field Q(15). For the clock input of the 4-
bit counter (CB4CE), QQ(8) from the right CB16CE is to be used as input.

It should be noted, that the counter macros used in the design shown in Figure 2.7 all have
the inputs CE (chip enable), and CLR (clear) which need to be tied to logic high and low, respec-
tively. This is accomplished by incorporating the components VVcc and Gnd and wiring them up to
the appropriate pins using the net command.

Internal nets and busses do not always have to have user specified names (for example
consider the nets which connect the inverters to the output buffers in the binary counter design).
As a general rule-of-thumb, however, one should always explicitly name the 1/0 nets (nets which
connect to 1/0 PADS), internal nets which connect to busses, and any internal net which the user
would like to appear in a simulation.

A couple of other items which should be pointed out include the fact that after a design is

entered, component positioning can be easily changed simply by entering the select and drag
mode (by pressing the .|? button) and clicking and holding the left mouse button after the cursor

is place on the object to be moved. Also entire sections of the design can be accessed as a single
entity by using standard windows based techniques to select multiple components, components in
a rectangular area, etc. These sets of objects can then be placed in the Windows clip board for
inclusion in other designs. Discussion of these techniques is beyond the scope of this manual but
such techniques can greatly speed up design entry as one gains hands-on experience.

After the design has been entered, Save the file (It doesn’t matter if you don’t close the
Schematic Editor, just remember to save the file. You can check your schematics diagram for
error by using the Check Schematics (Under Tool pull-down menu) feature provided by the tool.

Then return to the Project Navigator window.

14
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User Constraints Entry Phase

After the design is entered and saved, it is the job of the Xilinx Foundation software to
convert the user entered schematic into a form that can be used to configure the targeted FPGA/
CPLD device so that it will behave in the manner that is intended. This conversion process results
in the mapping of the desired the logical configuration into a form that can be implemented within
the internal FPGA architecture. It is at this point that users have the option of specifying certain
constraints which the complex mapping algorithms (place and route) [3,4] must adhere to when
making the implementation files. There are a number of such constraints which can be specified
(worst case timing, etc.), but the one that is of most importance in the binary counter design is
which pins on the Xilinx XC3S200 chip are going to be assigned to the input/output nets of the
design. In the binary counter design, there is only one input pin that runs from the S3Kit clock cir-
cuit into the Xilinx XC3S20E chip and there are only four output pins that are to connect the
external set of discrete LEDs.

Fortunately, the Xilinx libraries which come with each of the supported Xilinx FPGAs and
CPLDs have a set of symbolic names which correspond to each 1/0 pin on the chip. A cross refer-
ence can be created which specifies to the Xilinx software which symbolic pin name on the
FPGAJ/CPLD is to be assigned to the logical 1/0 net name used in the design. This cross reference
operation is contained within the User Constraint File which is associated with each project. If
such information is not in the User Constraint File, the Xilinx software will arbitrarily assign
FPGA pins to the design’s 1/0 nodes. (Note: there is a general rule -- the more constraints entered
by the user the more inefficient the implementation processes is in terms of processing time and
complexity of the design that can be implemented in a given FPGA/CPLD. In tightly packed/high
speed cases, it may be desirable to have the Xilinx software make its own 1/0 pin assignments and
external PC board circuitry designed to adhere to this placement [5].)

To lock a specified pin name with the logical 1/0 net name specified in the schematic (or
HDL for that matter), from the Project Navigator window, move the cursor to point to the top
hierarchy source tree located under the Sources in Project on the left-hand side of the window.
Click on Project pull-down menu and select New Source as shown in Figure 2.9. The user con-
straint file has extension ucf. Click next and observe the setup of the following two windows. No

changes are required for the next two windows. There are at least two methods to add constraints

15
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text. We will utilize the second method.

[E] EMM File

E Embedded Processar

[ Implementation Constraints File

#E|P (CoreGen & Architecture Wizard) File Name:
MEM File
[2) Schematic Iconstramﬂ
[ State Diagram
TestBench Waveform
[2] User Document

[ Verilog Module Ic'\xmnx\,tutonal-ch2 _l
[ Verilog Test Fixture

By vHDL Library

WVHDL Module

[F] VHDL Package

[#] VHDL TestBench

Location:

[V Addto project

<Eaclk I MNext > I Cancel | Help |

to the constraints file. The first method is using the GUI. The second method is by entering the

Figure 2.9: Entering User Constraints from the Project Navigator

For this design the desired schematic name to Xilinx XC3S200 Pin name cross reference

(i.e. Pin Locks) is shown in Table 2.1.

Table 2.1: Desired Pin Locking (Cross Reference) Configuration

. _— Schematic Xilinx
I/0 Pin Description XC4010XL
Net Name .

Pin Name
50 MHZ Clock CLK T9
Discrete LED #1 (Active High) BITO K12
Discrete LED #2 (Active High) BIT1 P14
Discrete LED #3 (Active High) BIT2 L12
Discrete LED #4 (Active High) BIT3 N14

Now open the constraint.ucf by going to the File pull-down menu and use the Open func-
tion. The resulting additions to the User Constraints File for the binary counter example are
shown in Figure 2.10 where the cross reference described in Table 2.1 was implemented using the

NET <schematic net name> LOC=<symbolic Xilinx pin name>
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construct. After these additions have been made to the User Constraints File one should Save the
work, Exit the Report Browser, and return to the Project Navigator window. You can double-click

on the constraint.ucf under Sources in Project to view the changes you have made.

nxilinx - Project Navigator - c\dlind\tutorial-ch2\tutorial-ch2 npl - [constraint. ucf] |
@ File Edit View Project Source Process Window Help il i IE’I_)Q

joema|zvElerE R (v ae]s o @] [ ennn Q|
2lx]

Sources in Project | 1 Net "clk" LOC =|"T9"" ;l
B tutorial-ch? 2 Net "ledO" LOC="K12";
B xc3s200-4A256 2 Net "ledl" LOC="P14";
=} .@ schematic (schematic.sch) It Net "led2" LOC="L12";
“ U] ‘constraintucf 5 Net "led3" Loc="N14";
B2 vioauie View | [ Snapsnat View | [T Ly View |
S
Pr for Source: " ucf" |
«~0  Add Existing Source
«~8  Create New Source
=@  UserConstraints
Create Timing Constraints
Eg\ Assign Package Pins
i B8 Creale Area Constraints
“|#  EditConstraints (Text)
-
[l | _>|_I
o lﬁmml @ constrainl.l
P [—
| Launching Application for process "Edit Constraints (Text)"
Launching Application for process "Edit Constraints (Text)"
>
< | =
4[4l > ] Console A FindinFies }, Wamings J Erors [
=

|Ln 1 Col 18

For Help. press F1

Figure 2.10: Adding Pin Locking Information to the Project Constraint File
Functional Simulation Phase

This is not a good example to show the working of functional simulation. Another lab will

be presented with ModelSim as the simulation tool.

17
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Synthesis/Implementation/Generate Programming File Phases

Now it is time to take the design through the compilation (consists of synthesis, implementa-
tion, and generate programming file) process.

Each sub-process can be activated by double-clicking at the location as shown in Figure
2.11. At the completion of each sub-process, the report can be found by clicking at the “+’ next the
the name of the sub-process. The information recorded in these files are the similar to those infor-
mation shown in the bottom window of the Project Navigator during the compilation process.
However, the information has been saved in files for easy viewing. You are required to observed the
report carefully and making sure that the synthesis process is carried out correctly. There are some
warning that can be ignored. However, there are some that absolutely needed your attention. One

such example is that you want a flip-flop for your design, but latch was synthesized!

2l
Sources in Project |
El tutorial-ch2
E-£3 xc3s200-4256
SRR schematic (schematic. sch)
] constraintuct

Double-clicking at
this location to

activated the process

Expand the “..T:l.m&\.liewl i Snapsnct Vew | ELNWWL/
function

Processes for Source: “schemat’rcy |
Add Existing Sour

er Constraints
Synthesize - XST
Implement Design
Generate Programming File

OOOREI0

B pracess View |

Figure 2.11: Compilation Process

Assuming that the Synthesis and Implementation phases have been carried out with any

error. Before you started the last sub-process, a property change is required. Left click on Generate

18
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Programming File then right click to select the Property menu. Under the Startup Options
menu, change the CCLK to JTAG Clock. Then, click OK.

Process Properties m

General Options | Configuration Options  Startup Options | Readback Options |

Property Name Value
FPGA Start-Up Clock JTAG Clock x>
Enable Internal Done Pipe I
Done (Output Events) Default (4)
Enable Outputs (Output Events) Default (5)
Release Write Enable (Output Events) Default (6)
Release DLL (Output Events) Default (NoW ait)
Match Cycle Auto
Crrive Done Pin High I

OK I Cancel | Default | Help |

Figure 2.12: Generate Programming File Properties

Now, double-click 3 to start the Generate Programming File process.

Programming (Device Configuration) Phase

To download a design to the targeted reconfigurable hardware (in this case the S3Kit) first
from the Processes for Source expands the Generate Programming File function, right click on
Configure Device (IMPACT) and select Run.

A=
Processes for Source: "schematic” | A|
-~ Create New Source
EI ~@F  Design Entry Utiliies
=@  UserConstraints
B3 Y Synthesize-XST
EOE Implement Design
= O_W Generate Programming File
""" o Programming File Generation |
58 Generate PROM. ACE, or JTAL_|
------- Configure Device (iIMPAG= =
" - |
= Rerun
B2 Process View |
Rerun All
G
Open Without Updating
Properties...

Figure 2.13: Configure Device
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The default setup should be just fine. The flow is as the following: Boundary-Scan Mode
—» Automatically connect to cable and identify Boundary-Scan chain. Once the chain has been

identified, the following message appears.

Boundary-Scan Chain Contents Summary m

\:‘) There were 2 devices detected in the boundary-scan chain.
iMPACT will now direct you to associate a programming ar
BSDL file with each device, starting with the first .

Click OK. Now, a programming file is to be selected.

Assign New Configuration File B

Look in: I:‘_’Hutorial-chE ﬂ &= £k Fw

_ projnav
53 _ngo

I schematic

File name: |schematic

Files oftype: |AII Design Files j Cancel

| Cancel all | Bypass |

4

Click Open. The following message appears. Click Bypass on the second selection win-

dow.
To download the design into the S3Kit simply right click on chip (xc3s200) and select

Program. No changes are required under Program Options. Click OK to program the FPGA.
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O untitled [Configuration Made] - iIMPACT - |of x]
File Edit Wiew Mode Operations Cutput Help
IDSHE| s @ &2t OS2 g

Boundary-Scan | Slave Serial| SelectMAP| Desktop Configuration |

IDI E EonLm
xc3s200 xcfl2s 5
schemaichit  BYPASS
TDO e
Executing command...

Elapsed time = 5 sec. _‘J

Device #1 selected

Device £1 selected

Device #1 selected

([ *** BATCH CMD : Program p 1

PROGRESS START - Starting Operation.

Validating chain ..

Boundary-scan chain validated successfully.

'1"Programming device. .

=

For Help, press F1 |Configuration Mode  |Boundary-Scan |Paraliel i lipt1 200t

Figure 2.14: Programming the FPGA

The design should be configured and functioning as intended. Thus for the four bit counter

example one should see the four lower order S3Kit LEDs counting through the binary sequence.
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Chapter 3: Hardware Description Language Design Example

Example

In this chapter, a binary to seven segment display converter example will be used to illus-
trate how a design can be entered using VHDL [6], synthesized, simulated, and implemented on
S3Kit. The design will is to drive an external seven-segment common anode LED as shown in
Figure 1.1. In a similar manner, the inputs to this design will be driven directly by the first four
DIP switches (labeled SWO -- SW3).

Background
A single seven-segment indicator can be used to display the digits *0” through ‘9’ and the

hexadecimal symbols ‘A’ through ‘F’ (with symbols ‘b’, and ‘d’ being displayed in lower case) by
lighting up the appropriate set of segments. For example, the number ‘8’ can be displayed by illu-
minating all seven segments and the lower case letter ‘b’ can be displayed by illuminating the seg-

ments labeled c,d,e,f, and g for the seven segment display element that is shown in Figure 3.1.:

7 Seg LED
s
- a o2
f b‘ Logic High N
L9 Lights Oﬂ/vvvg@—L
Segments C
e c‘ .
d Y |
&M@H

Common Cathode

Figure 3.1: Seven Segment Display Unit

One common type of seven segment display unit utilizes Light Emitting Diodes, LEDs, as
the display elements. In this arrangement, each segment that makes up the seven segment display
unit is a separate light emitting diode (LED) that will light up when it is forward biased. Often
commercially available seven-segment LED display units minimize the number of external pins
needed by internally connecting together one node of each of the seven individual LEDs. In one

arrangement, the common cathode, the cathodes of the diodes have a common connection point. If
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this common point is connected to ground and a set of current limiting resistors are connected in
series with the individual segments then each segment of the display can be independently illumi-
nated by placing a logic high on the corresponding segment lead (assuming the logic device is
capable of sourcing enough current). The binary to seven segment display example assumes that
an external common cathode seven segment LED will be used as the targeted display element
with the common cathode point being connected to ground. Thus a logic high will be required to
light up each segment.

Figure 3.2 shows a block diagram of the display converter circuit that is to be designed.
The display converter circuit is to contain the logic necessary to drive the seven segment display
in a manner in which the hexadecimal symbol associated with the four bit input is displayed. Thus
the symbol 0 would be displayed if all of the input bits were logic low, and the symbol 8 would be
displayed if bit I<3> was high and the rest low. Table 3.1 shows the desired display configuration
for each of the 16 possible input scenarios.

outputs
to LED
MSB O<L> N
Ry . . g/ a
Digital Logic [0<5> If b
inputs 1<3>—» I
from I<2>—>» 0<6> g
external 1<1>—p to be
DIP I<0O>—p O<4> I e c
switches Designed 0<3> I
< o d
\ j—

Figure 3.2: Display Converter Seven Segment Display System Overview
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Table 3.1: Desired LED Display Configurations
Inputs Display Inputs Display
13 12 11 10 Configuration 13 12 11 10 | Configuration
00|00 l 10|00 H
00|01 | 110]01 u
olo|1]o0 C 1/of1]o0 H
00|11 J 11011 b
01|00 U 1l1]0|o0 r
01|01 G 101]0]1 O
01|10 H 1l1]1]o0 a
01]1]1 | 1111 =

Design Entry

HDLs are textural representations that are used to model the structure and/or behavior of
the system hardware. They are analogous in some ways to high-level software languages such as
C, FORTRAN or C++ with the important distinction that HDLs have special constructs specifi-
cally designed to model the characteristics of digital hardware. The major difference in HDLs and
high-level software languages are that HDL’s can easily model the timing attributes and the highly
concurrent aspects of digital hardware (i.e. in physical hardware many events often happen at the

same time). In addition HDL’s have the power to fully describe a logic system using both behav-

ioral and structural design techniques.

To enter the binary to hexadecimal converter example using an HDL, first invoke the Xil-

inx Project Navigator window in the same manner as was done previously, by double clicking

on the Project Navigator icon.
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As with the previous example that was presented in Chapter 2, the Project Navigator will
try to display the previously selected project. Under File pull-down menu, select New Project.

Select this option and enter according to Figure as shown in Figure 3.3. Then click the Next but-

ton.
New Project n

—Entera Name and Location for the Project
Project Name Project Location
tutorial-ch3 cilinkltutorial-ch3 J

— Selectthe type of Top-Level module for the Project
Top-Level Module Type
[Foc =

< Hachk | Next > I Cancel I Help

Figure 3.3: New Project Window

At this point a New Project window will appear as shown in Figure 3.4. Make sure that
the Flow field for this example is set to HDL, since we are demonstrating in this example design
entry made through the use of the hardware description language, VHDL. Also, make sure that
the device selection and parameters are correct. Then click on the Next button. We will not be

adding source at this time, so click on the Next button on the following two windows.
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New Project n
i Selectthe Device and Design Flow for the Project
Property Name Value
Device Family Spartan3
Device xc3s200
Package 266
Speed Grade 4 Zl
Top-Level Module Type Schematic
Synthesis Tool XST (VHDLVerilog)
Simulator Other
Generated Simulation Language VHDL

< Back I MNext = I Cancel | Help

Figure 3.4: New Project Window

Once the project has been successfully created, we will utilize the VHDL basic module
creation tool to provide us with a VHDL template. Use the Project pull-down menu and select
New Source. Figure 3.5 shows the steps.

For this example, we want to have a four bit input port which we will call 1. The individual
signals of the input port are to be named 1<3> I<2>, I<1>, 1<0>, respectively with 1<3> acting
as the most significant bit. To do this, first enter I in the Port Name field. Then set the range of
the Bus field (using the up and down arrows) to be 3:0. After making sure the Direction of the
bus is an Input (its default). The output bus of the hexadecimal converter example should be
seven bits wide (one for each segment of the LED). We will call this bus O, with the individual
signals which make up the bus being named O<6>, O<5> ... O<1>, O<0>, respectively (with
0<6> acting as the most significant bit, i.e. the signal to be connected to segment ‘g’ of the LED
and O<0> acting as the least significant bit, i.e. the signal which is to be connected to segment ‘a’
of the LED). This can be accomplished by entering O in the Port Name field, setting the range to
6:0 in the Bus field, selecting Output in the Direction field and then pressing the Next button.

After completing the interfacing details, the VHDL template window (Figure 3.6) will
appear and will contain the skeleton code for the VHDL model. VHDL files contain two main
sections, the Entity and the Architecture. The Entity section was directly created by the wizard
where it describes the interface between the design being modeled and the outside world. The

wizard also automatically created a portion of the Architecture section which describes how the
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design is to function. It is now up to the user to supply the additional VHDL statements needed to
fully describe the implementation. The VHDL template file which was created for the binary to
hexadecimal example is shown in Figure 3.7.

mEmbedded Processor
P (CoreGen & Architecture Wizard)
8] Schematic
[E] State Diagram File Name-
TestBench Waveform
[2] User Document bintohex vhd
[¥] Verilog Module
[f] Verilog Test Fixture
L ti
) VHDL Library i
[¥] VHDL Module |c‘\xi|inx\tutoria|-ch3 |
[#] VHDL Package
&1 VHDL TestBench
[v Add to project
Bk Mext > Cancel Help
Define VHDL Source m
Entity Namelbmtohex
Architecture Name IBehavioraI
Port Name Direction MSB LSB i'
I in 3 0
o] in 6 0
Enb{ in
Enb1 in
Enb2 in
Enb3| in
in
in
in
in
in
in
in LI
< Back I Mext > I Cancel | Help |

Figure 3.5: New VHDL Source
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I’i;brary IEEE; :J
use IEEE.STD_LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;

use LIEEE.STD LOGIC UNSIGNED.ALL;

the: following lines to use the declarations that are
d for instantiating Xilinx primitive components.
ISTIM:

WND DR W N s

5 - Components.all:;

i1 entity bintohex is

12 Port { I = in

132 o Sl
14 BhbO = i
15 Enbi - i
10 Bnb2 : i

17 Enb3 : i
18 end bintohex;

[20. architecture Behavioral of bintohex is

=2 begin

25 end Behawvioral;

« o

[# bintohex...

Figure 3.6: VHDL Template

(13 ”

The structure of the VHDL file can be described as follows. Double dashes, “--”, are used
to introduce comments and semicolons are used to terminate the statements. The Entity section
that was produced by the wizard is incomplete, refer to Figure 3.7 for modifications. It begins
with the VHDL keyword entity followed by the user defined name of the logic design (in this
case bintohex). The entity name is then followed by the keywords is port that designates that a list
of input/output ports is to follow. In this case, we have two bus signals that are defined. One is
named | (for input) which is a four member input vector (direction specified by the in keyword),
1<3> -- I<0>, with 1<3> acting as the most significant bit (this is due to the downto keyword).
The other is a seven member output vector (direction specified by the out keyword) which is
named O, which has seven members O<6> -- O<0>. [Note: The sTD_LoGIC_VECTOR defines the
vector type. It is declared in the library IEEE.std_logic_1164.all. It is possible for the user to declare

arbitrary data types in VHDL. The data types defined in this library are standardized allowing for
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increased portability among VHDL simulators and synthesizers.] The entity section ends with the

end statement followed by the design name.

10 -~
11=> entity bintohex is -_]
12 Port { I : in std_1 r (3 downto 0);

12 O : ‘out-std £ or (6 downto 0):

14 Enb0, Enbl, Enb2, Enb3 : out std logic);

15 end bintohex;

18

17 architecture Behavioral of bintochex is L. )

18 begin This is required

- Eﬁﬁi e S < to activate/deactivate the

= Enb2 <= '1'; sevent-segment display.

== Enb3 <= '1';

== with I select

|24 0O <= "1000000"™ when "0000",

25 "1111001™ when "0001",

25 "0100100" when "0010",

=7 "0110000" when "0011",

|22 "0011001™ when "0100",

|29 "0010010™ when "0101",

20 "0000010™ when "0110",

21 "1111000" when "0111",

e "g000000" when "1000",

23 "o010000 when "1001",

24 "0001000 when "1010",

25 "0000011™ when ™1011",

=5 "1000110" when "1100",

37 "0100001"™ when ™"1101",

22 "0000110™ when ™1110",

29 "0001110" when T11311",

[0 By " when others; -
41 end Behavioral; =
KN Ll_l
_@ bintohex I

Figure 3.7: VHDL Template for bintohex Example

The desired behavior of the Entity section is modeled in the Architecture section. This sec-
tion begins with the keyword architecture which is followed by an arbitrarily defined name for
the architecture (in this case the wizard choose to use, bintohex_arch) which is paired with the
identity of the Entity using the of keyword followed by the Entity name (i.e. in this case of binto-
hex). The begin keyword is used to separate the declarative part of the model from the statement
part of the Architecture section. The architecture declarative part is used to make declarations for
such items type, signals, and components. For the model presented in Figure 3.6, no declarations
are needed to represent the design so this part is not entered. The VHDL modeling statements are
to be placed in the architecture statement area of the model which is located between the begin
keyword and the end keyword.

Figure 3.7 shows the final VHDL model which was created for the binary to hexadecimal
converter example by adding additional comments and an additional architecture statement to the
original template file that was created by the wizard. Comments were added as necessary through-

out the model and a with... select...when statement was added to the architecture section. The
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with... select...when statement is analogous in many ways to a case statement in the C program-

ming language in that provides selective signal assignments. It has the following structure:

with input_signal select
output_signal <= value_a when value_1,
value b when value 2,

value_x when last value,
value_z when others;

When the input signal equals value_1 then the output_signal is set to value_a. When the
input_signal equals value_2 the output_signal will be set to value_b and so on. In this example,
this construct is being used to implement the truth table that describes the desired binary to hexa-
decimal converter operation (but unlike most truth tables the inputs appear on the right side). The
input_signal and output_signal are both vectors that are defined within the library package
IEEE.std_logic_1164.all. In VHDL, the logic values that are support include ‘0" for logic low
(forcing 0), “1” for logic high (forcing 1), and *-’ for don’t care.

[Note: This illustrates manual editing of the VHDL file without any outside assistance. For
more complex designs one might want to utilize the built-in Language Template Tool. To use the
Language Template Tool, from the pull-down menu, select Edit, then click on the Language
Template option (second from bottom of the list). The Language Template window as shown in

Figure 3.8 will appear. At the touch of the mouse button additional information will be presented
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and constructs for large sections of the design can automatically be entered into the design. This is

a very powerful tool, the detailed description of which is beyond the scope of this manual.]]

component ingtantiation
conditional signal azsignment
conztant declaration
Converzion Functions
Dezign library specification
entity declaration

ewit statement

for-loop statement
furnction declaration
generate statement

it statement

library, packages

nest statement

port declaration

procedure declaration
process statement
zelected signal aszignment
zignal aszignment

zighal declaration

B R R R R a e ] e R o R N e ] e R N e R e

[

operatars o

SWRENEE
Templates: lﬂ .‘J
-] ABEL
M3 UCF CasSe <expression> is
-1 Verilog when <choicess> =»
=-{3 vHDL <statementsr
|:r'J {21 Component [rstantiation when <choices> =»
=123 Language Templates <statementss
. architecture bady when others =»
block statement <3tatementsx
case statement end caze;
component declaration —— example:

M = e

G whigirialy |l |V g
== e T

= whern 3 to 10 =
L2 B oS

== when others =>

= null;

——end case:;

<1

wf

Bl
--_Q Language TI

Figure 3.8: Language Template Window (VHDL)

After the VHDL model has been entered, one needs to check the syntactical correctness of

the modeling code. This can be done from the Project Navigator by double clicking on

53 Synthesis - XST . Assuming that no syntax errors exist in the above HDL code, we will

move on to the next step. Once again, ModelSim will be utilized as functional simulation too and

this will be presented in another tutorial.

31



Version 1.01  1/5/2004

User Constraints Entry Phase

In this design example, it will be necessary to assign (lock) the four logical inputs of the
binary to hexadecimal design to the set of DIP switches (SW1, SW2, SW3, and SW4) located on
S3Kit and assign the seven outputs to the jumper locations which will be used to drive the individ-
ual segments of the externally connected common anode seven segment LED display.

For this design the desired schematic name to Xilinx XC3S200 Pin name cross reference

(i.e. Pin Locks) is shown in Table 3.2.

Table 3.2: Desired Pin Locking (Cross Reference) Configuration

I/0 Pin Description “N\e/tl’_’ﬁ;me XC?TgIZIS())(Pin
Name
DIP Switch SWO0 I<0> F12
DIP Switch SW1 I<1> G12
DIP Switch SW2 1<2> H14
DIP Switch SW3 1<3> H14
Segment ‘a’ of Digit #0 0<0> El4
Segment ‘b’ of Digit #0 Oo<1> G13
Segment ‘¢’ of Digit #0 O<2> N15
Segment ‘d’ of Digit #0 0<3> P15
Segment ‘e’ of Digit #0 O<4> R16
Segment ‘f’ of Digit #0 O<5> F13
Segment ‘g’ of Digit #0 0<6> N16
Enable/Disable LED #0 EnbO D14
Enable/Disable LED #1 Enbl G14
Enable/Disable LED #2 Enb2 F14
Enable/Disable LED #3 Enb3 E13

The resulting additions to the User Constraints File are shown in Figure 3.9 where the
cross reference described in Table 3.2. After these additions have been made to the User Con-

straints File one should Save the work, and return to the Project Manager window.
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i Net 0<0> Loc = "E14"; =
2 Net 0<1> Loc = "G13";

2 Net 0<2> Loc = "N15";

2 Net 0<3> Loc = "P15";

5 Net 0<4> Loc = "R16";

8 Net 0<5> Loc = "F13":

7 Net 0<6> Loc = "N1lé";

=

8 Net I<0> Loc = "F12";

10 Net I<1> L
11 Net I<2> L
12 Net I<3> L

1a Net "EnbO0O"
15 Net "Enbl"
16 Net "Enb2"
iz Net "Enb3"

4

oc = "G12";
oc = "Hi14";
oc =: "H13";

Loc = "D14";
Loc = "G14"™;
Loc = "F14";
Loc = "E13";

-

[/ bintohex @constreint..l

Figure 3.9: Adding Pin Locking Information to the Project Constraint File
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Synthesis/Implementation/Generate Programming File Phases
This section is similar to the one presented in Chapter 2, readers are referred to Chapter 2

for Synthesis/Implementation/Generate Programming File Phases.

Programming (Configuration) Phase

This phase is identical to that described in Chapter 2. Please refer to this material to con-
figure the S3K:it for the binary to hexadecimal converter design. When the design has been con-
figured the external LED display should display the hexadecimal symbol which represents the

current state of the four external DIP switches.
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Chapter 4. Combined Schematic Capture/HDL Design Example

Example

In this chapter, the two previous design examples from Chapter 2 (the binary counter) and
Chapter 3 (the binary to seven segment hexadecimal converter) will be combined to form a com-
plete hexadecimal counter design. The final design will result in a new hexadecimal symbol being
displayed on the external seven segment LED after each master clock pulse of ~1HZ. The hexa-
decimal counter will be constructed by connecting the outputs of the binary counter design
directly to the inputs to the binary to seven segment hexadecimal converter as shown in Figure
4.1. As in the binary counter example of Chapter 2, the clocking signal will originate from an
internal 50 MHZ oscillator which will be directed through a 24 bit prescaler network. To mini-

mize the design effort and illustrate the mechanics of hybrid design methodology, this design is to

be entered using both schematic capture and HDL methodology and constructs.

Bintohex Converter Example (implemented in VHDL in Chapter 3)

16 MHZ

System
Clock

Binary Counter Example (implemented using Schematic Capture in Chapter 2)

Outputs
to LED
N
a: \@ .
f bI o<i> Binary
0|
e CI O<2>
d I O<3>|  Converter
/I<3> 1<25 1<1{ 1<0>
~1HZ
ivi i Clock
> (zal\é:? ErreLsggfgr) —— | 4-bit Binary Counter

Figure 4.1: Hexadecimal Counter Example
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Setting up the Project

As in the previous cases, to enter this design, first start the Project Navigator of Xilinx
Foundation Series 6.3i by double clicking on the Project Navigator. For this case, we would to
Create a New Project with Schematic as the Top-Level Module Type. Select this option as

shown in Figure 4.2. Then click on the Next button.

— Enter 2 Name and Location for the Project

Project Name: Project Location:

tutorial-ch4 ctutorial-ch4 |

— Selectthe type of Top-Level module forthe Project

Top-Level Module Type:

Schemaic |3

Figure 4.2: New Project Setup

A blank schematic file will be added to be the top-level for this hybrid project (Figure 4.3).
e <] x]

e IE Embedded Processar
=& 1P (CoreGen & Architecture Wizard)

2] Schemstic
|— [2] State Diagram il Mame:
i TestBench Waveform
= |[@ User Document |schematics-top|eve||

[¥] Verilog Module
[:] Verilog Test Fixture

I VHDL Library Lo .
L [¥] VHDL Module |c‘\tutoria|-ch4 J
[) VHDL Package
[ VHDL Test Bench
Cr
At

ce

[v' Add to project

< EaEk MNext > Cancel | Help | |

Figure 4.3: New Schematic File As Top Level
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The first step in entering the hybrid hexadecimal counter example will be to enter or copy

the logical schematic elements used to create the bcount (binary counter) example of Chapter 2

into the schematic associated with this design. Then re-enter the binary counter design (but with-

out the input/output buffers). The schematic file and the bintohex VHDL module created in Chap-

ter 2 and Chapter 3, respectively, are added as shown in Figure 4.4.

—Add Existing Sources

Source File

schematic sch

Type

Copy to Project

=
Add Source...

-

bintohex.vhd

VHDL Design File

Remove I

R Y

i e

~|

Add existing sources to the project (optional). Additional sources can be added after project
creation using the "Project->Add Source” or "Project>Add Copy of Source” commands.

< Back |

Next > |

Cancel | Help

Figure 4.4: Add previously created sources to this project

The next step is to convert the binary to hexadecimal converter VHDL model developed in

Chapter 3 into a macro which will appear as a symbol in the schematic. To do this, return to the

Project Navigator window, select the bintohex-behavior and click on the “+’ next to the Design

Entry Utilities within Processes for Source. Then, double-click on Create Schematic Symbol.

These steps are shown in Figure 4.5.
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Sources in Project

=} E tutorial-ch4
- [B schematics-toplevel sch

E-£3 xc3s200-4256
-~ [¥) bintohex-behavioral (bintohex.vhd)
[ schematic (schematic sch)

= 02 osuie Views | (8 SnapsnotView | [T) Livvery views |

2] =

Processes for Source: "bintohex-behavioral" |

Add Existing Source

Create New Source

Design Entry Utilities

G

i View Command Line Log File

View VHDL Instantiation Template

&  UserConstraints

3 Synthesize-XST

3 Implemant Design

3 Generate Programming File
Programming File Generation Ref
Q Generate PROM, ACE. or JTAGF
o Canfigure Device (i(MPACT)

L |
‘.'QPmoessViewl

Figure 4.5: Create a bintohex symbol

Once the symbol for the VHDL module has been created, the symbol for the 4-bit counter
will also need to be created. In order to do this, we need to modified the schematics.sch from Chap-
ter 2 which has been added to this project. As shown in Figure 4.6, the buffers for sch.sch have

been removed. When the modifications have been made, save the schematic file and create a sym-
bol with the steps shown for the HDL module.
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v CB4CE
a1 [
a3 i
T—
;
J_—

Woo

G = CB16CE
. apism ———a . . R e

Figure 4.6: Modify the 4-bit counter (with all the buffers removed)

With both symbols successfully created, return to Project Navigator and enter schemat-

ics.sch to add the symbols to schematics.sch. This is shown in Figure 4.7.
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£cs Xilinx ECS - [schematics-toplevel]
K File Edit View Add Tools Window Help

DEEES| 2o H|[@ax=anE

|sgsmam||sw

KUy =[22 [ ~0o\OA[@DC &|v|[sAamm]

=

Csns | Symbols |

LCategories

<=4l Symbols—> -

Arithmetic
Butfer
Carry_Logic
Comparator
Counter
DDR Flip_Flop
Decoder
Flip_Flop
General

10
10_FlipFlop
10_Latch
Latch

Logic

LuT

kap LI

Symhbols

hintohex

Symbaol Mame Filter

schematic

- o - . “le20

el

bintohex

e

=]

e

e

o

Orientation X
!Rutate o LI o
] 3
Sl I E
schematics-t I schematic
Ready [2048.1558] |spartan3

Figure 4.7: Add the created symbols in schematics.sch

The complete connections for Figure 4.7 is shown in Figure 4.8.

schematic bintohex-
B o Y Enty) FLXN_20
P, OB
v N el [T
% et : : = . J
2 ————a = e XOIN_22>
OBUF
a0 —F—s- S
e e EE )
OBUF
—
o
——
¥ 5 QBUT . . 1
=
OBUF
QeUF
e I E(E )
OBUF
Be———"E YLEN_20
oEUF

40

Figure 4.8: Connections in schematics.sch
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Now the design can be completed using the schematic capture techniques which have
already been presented in Chapter 2. The completed schematic with its associated components
and net/bus names are shown in Figure 4.8. After the schematic is successfully entered, the design

should be Saved and the user should return to the Project Navigator window.

User Constraints Entry Phase

In this hybrid HDL/schematic capture hexadecimal counter design example, it will be
necessary to assign the CLK signal to the S3Kit 50MHz internal clock as was done with the
design of Chapter 2 and assign the seven outputs to the jumper locations which will be used to
drive the individual seven segments of the LED display as was done with the binary to hexadeci-
mal converter example of Chapter 3. In this case, the binary to hexadecimal converter design is
used as a component macro so the schematic capture net names will be used to specify which sig-
nals one would like to lock to specific XC3S200 pins.

For this hybrid design, the desired schematic name to Xilinx XC3S200 Pin name cross ref-
erence (i.e. Pin Locks) will be as shown in Table 4.1. (Note: in this hybrid design, the outputs of
the binary counter design now internally drive the inputs to the binary to hexadecimal converter
so only the input to the first design and outputs to the second need to be routed to the Xilinx’s
XC3S200 I/0 pins.)

Table 4.1: Desired Pin Locking (cross reference) Configuration

: - Schematic Xilinx
I/0 Pin Description Net Narme XC_34010XL
Pin Name
50MHz Clock CLK T9
Segment ‘a’ of Digit #0 0<0> El4
Segment ‘b’ of Digit #0 O<1> G13
Segment ‘¢’ of Digit #0 0<2> N15
Segment ‘d’ of Digit #0 0<3> P15
Segment ‘e’ of Digit #0 O<4> R16
Segment ‘f’ of Digit #0 0<5> F13
Segment ‘g’ of Digit #0 0<6> N16
Enable/Disable LED #0 EnbO D14
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Table 4.1: Desired Pin Locking (cross reference) Configuration

) . Schematic Xilinx
I/0 Pin Description XC4010XL
Net Name .
Pin Name
Enable/Disable LED #1 Enbl G14
Enable/Disable LED #2 Enb2 F14
Enable/Disable LED #3 Enb3 E13

The resulting additions to the User Constraints File are shown in Figure 4.9.
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'IF13";
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Figure 4.9: Constraints

NET <schematic net name> LOC=<symbolic Xilinx pin name>

construct. After these additions have been made to the User Constraints File one should

Save the work, Exit the Report Browser, and return to the Project Manager window.
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Synthesis/Implementation/Generate Programming File Phases
This section is similar to the one presented in Chapter 2/3, readers are referred to Chapter

2 or 3 for Synthesis/Implementation/Generate Programming File Phases. The process is once
again shown in Figure 4.10.

2l
Sources in Project |
B tutorial-chd
=£3 xe35200-41256
=-[8 toplevel (foplevel.sch)
@ constraintuct
~[¥ bintohex-behavioral (bintohex vhd)
- schematic (schematic.sch)
N B Moo View | 10 Snzpsnonview | [T Livary View |
=]

Processes for Source: "toplevel” |
.0  Add Existing Source
#~[  Create New Source
EEl- & Design Entry Utlites
[E2) W User Constraints
=83 T Synthesize - XST
#-43 9 Implement Design
2 30? Genarate Programming File
Programming File Generation Ref
S Generate PROM, ACE, or JTAGF

=" Configure Device (MPACT)

< |
| 2 Procees Ve

Figure 4.10: Top-level compilation

Programming (Configuration) Phase

This phase is identical to that described in Chapter 2. Please refer to this material to con-
figure the S3Kit. When the design has been configured the external LED display should succes-
sively and repetitively display the hexadecimal pattern ‘0’ to ‘F’ in sequence (lowest to highest

with wrap around) with out requiring any interaction from the user.
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